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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Refer to the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e (Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The Ardbox Family PLCs are Open Type Controllers. It is required that you install the
Ardbox PLC in a housing, cabinet, or electric control room. Entry to the housing,
cabinet, or electric control room should be limited to authorized personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when Ardbox family PLCs.
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e In case of installation or maintenance of the Ardbox please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.

e Reportez-vous au Guide de I'utilisateur du contréleur pour les considérations de
cablage.

e Avant d'utiliser ce produit, il incombe a I'utilisateur de lire le Guide de 'utilisateur du
produit et la documentation qui I'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

e La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a |'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

e Les automates de la famille Ardbox sont des controleurs de type ouvert. Il est
nécessaire d'installer I'automate Ardbox dans un boitier, une armoire ou une salle de
controle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de I'installation des automates de la
famille Ardbox.

e En cas d'installation ou de maintenance du Ardbox, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging - Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification — Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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1. Ardbox Relay HF w/ WiFi & BLE: General Features

Supply Vaoltage

24 \cc

I/Os

COMPACT PLC ARDUINO ARDBOX 201/0s RELAY HF

Fuse protection (2.5A)

Analog Output 8bit
(0-10Vcce)

Input Voltage 12 to 24vdc Polarity protection
Input rated voltage 24 Vde
Rated Power 30W
| Max. 1,5A
Size 100x45x115
Clock Speed 16MHz
32KB of which 4KB are used by
Flash Memory bootloader
SRAM 2.5KB
EEPROM 1KB
. . 12C -- USB -- RS232 -- RS485 --
Communications SPI - TTL — WiFi — BLE RS485
TOTAL Input points 10
TOTAL Output points 10
0 to 10Vac
Input Impedance: 39K
Separated PCB ground
An/Dig Input 10bit Rated Voltage: 10Vac
0-10V. 5 to 24Vdc
(©- ce) | min: 2to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc
* Interrupt isolated Input o iy 28 5 to 24Vdc
I min: 2to 12 mA I min: 3/6 mA
HS Galvanic Isolation Se arated PCB around
(24Vvce) Rated Voltage: 24Vdc P 9
0 to 10Vac
I max: 20 mA

Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated Output
(24vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

PWM Isolated Output
8hit (24vce)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

PWM lIsolated
Output 8bit (24vcc)

Digital Isolated Output
Relay

220V Vdc
| max: 5A
Galvanic Isolation
Diode protected for Relay

Expandability

12C — RS232 — RS485 — SPI - TTL
— WiFi —BLE

Reference

007001001200

11
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2. Technical Specifications

2.1  General Specifications:

Power supply

voltage DC power supply

12 to 24Vdc -

Operating

voltage range DC power supply

11.4t0 25.4Vdc ===

Power
consumption DC power supply 30VAC max.
External Power supply voltage [ 24vdc ===
power supply
Power supply output 700 mA

capacity

Insulation resistance

20MQ min. at 500Vdc between the AC terminals and the protective ground
terminal.

Dielectric strength

2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA
max. Between all the external AC terminals and the protective earth
terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 350g max.

2.2 Performance Specification:

Arduino Board

ARDUINO LEONARDO

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutorial/HomePage

Microcontroller

ATmega32u4

Flash Memory

32KB of which 4KB are used by bootloader

Program capacity (SRAM) 2.5KB
EEPROM 1KB
Clock Speed 16MHz

12
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Symbology
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Table that includes all the symbology that is used in the serigraph of the Ardbox Relay WiFi&BLE:

Svmbol Standard No./ Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / : : .
] Graphical symbols 5031 / Direct Inohcates that_ the equipment |§
E EE =Em suitable for direct current only;
for use on Current . : ;
, to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols , suitable for alternating current
N for use on 5032 / Alternating only; to identify relevant
; Current .
equipment terminals
IEC 60417 /
Graphical symbols 5130 / Pulse To _|dent|fy the_control by
for use on which a pulse is started.
: General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
‘ . Ground : - ;
equipment 5019 is explicily required.
IEC 60417 / . . .
Graphical symbols To identify the swﬁch by
means of which the signal
for use on 5115/ Slgnal lamp : )
) lamp(s) is (are) switched on or
equipment off

q

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking licabl .
93/42/EEC applicable Eurqpean Union
regulations
ISO 7000/ di il
Graphical symbols Indicates a potentially
for use on 0434B / hazardous situation which, if
equibment Warning symbol not avoided, could result in
quip death or serious injury
ISO 7000/ To indicate hazards arisin
Graphical symbols | 5036 / Dangerous f d I 9
for Use on Voltage rom dangerous voltages
equipment

13
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3. Precautions

Read this manual before attempting to use the ARDBOX 20 I/Os Relay HF WIFI & BLE and
follow its descriptions for reference during operation.

3.1 Arduino Board

The ARDBOX 20 1/Os Relay HF WIFI & BLE PLCs include Arduino Leonardo Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Ardbox according to the performance specifications described in this
manual.

Before using ARDBOX 20 I/Os Relay HF WIFI & BLE under different conditions from what has
been specified in this manual or integrating ARDBOX 20 I/Os Relay HF WIFI & BLE to nuclear
control systems, railroad systems, aviation systems, vehicles, combustion systems, medical
equipment, amusement machines, safety equipment and other systems, machines, and
equipment that may have a serious influence on lives and property if used improperly, consult
your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics of Ardbox are sufficient for the systems, machines, and equipment, and be sure
to provide the systems, machines, and equipment double safety mechanisms. This manual
provides information for programming and operating the Ardbox.

14
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4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Furthermore Industrial Shields provides boards for programming the PLCs much easier.

Basically it is no needed to define the pins and if that pins are inputs or outputs. Everything is
set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.0 or above (better to always have the latest version).

Steps:
1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X
Settings  Networl:
Sketchbook lacation:

C:\Users\Abert\Documents\Arduino Browse

Editor language: English (English) | (requires restart of Arduino)
Editor font size: 15
Interface scale: Automatic | 100 5 %  (requires restart of Arduina)

Show verbose output during: [+/] compilation upload
Compiler warnings: Nore

[ pisplay line numbers

[[JEnable Code Folding

Werify code after upload

[[] Use external editor

Check for updates on startup

Update sketch files to new extension on save (pde -> .ina)
Save when verifying or uploading

Additional Boards Manager URLs:  http://apps.industrialshields.com/main/arduino/boards package_industrialshields_inde:| 51
More preferences can be edited directly in the file

C:\Users\Albert\AppData\_oral\Arduinal5\preferences, txt

(edit only when Arduing is not running)

OK Cancel

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

15
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4. Go to: Tools -> Board: ... -> Boards Manager

@ skeich marl6a | Arduino 180
File Edit Sketch Tools Help

Auto Format Cul+T
Archive Sketch
Fix Encoding & Reload

Serial Monitor Ctrl4ShiftsM
Sertal Plotter Cul+Shittsl

WFi101 Finmware Updater

Board: “M-Duino lamily” + Boards Manager...
Indusirial Shvelds: "M-Duino 58+ 7 Arduino AVR Boards
" pon Arduino Yin
"t Get Board Info Asduino/Gensino Una
, Programmer: “Archiino as ISP i Arduino Duemilanove or Diecimila

Arduine Nano

Arcuino/Gerano Mega o Mega 2560
Arduin Mega ADK

Arduing Leonardo

Arduina Leonardo ETH
Arduino/Genuine Micro

Arduino Esplora

Arduino Mini

Arduina Ethernet

Bum Bootioader

Arcuina Fio
Arduino BT

LilyPad Archuino USB
LilyPad Arduino

Arduine Pro of Pro Min
Arduing NG or older
Arduino Robot Control
Arduing Robot Motor
Arduino Gemma

Adatruit Cireuit Playground
Arduing Yuin Mini
Arduina Incustrial 101
Linina One

Arching Uno Wikl

Industrial §
Ardbox tamily
* M-Duino family

5. Search for industrialshields.

Rev. 2: 04-02-2022

& Boards Manager

Type All ~ | |industrialshields

industrialshields

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

~ Install

Close

16
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6. Click install (selecting the latest version).

Following this steps you will be able to use now the Industrial Shields Boards:

ch_aug26a | Arduing 189 - o x
etch Tools Help

Auto Format et

Archive Sketch

Fix Encoding & Reload

Manage Libraries. Cri+Shiftel
Serial Monitor Cur+ShifteM
Serial Plotter Cur+Shift+L

WIFi101 / WIFININA Firmware Updater

Board: “Ardbox WiFI/BT family” 3 Boards Manager
Model: *Ardbox Anaiog HF-+ w/ HW RS-232 WiFi/BT* >
MSStack-FIRE

Get Board Info MSStick-C

ODROID ESP32

Heltec Wifi Kit 32

Heitec Wifi LoRa 32

Heltec WiFi LoRa 32(v2)

Heltec Wireless Stick

ESPectro32
Microduino-Core€sp32

ALKS ESPR2

WiPy 30

BPI-BIT

Silicognition WESF32

T-Beam

D-duino-32

LoPy

Lopy4

OROCA EduBot

ESP32 FM DevKit

Frog Board ESP32

Al Thinker ESP32-CAM

SparkFun LoRa Gateway 1-Channel

Programmer. *Arduino Gemma"
Bum Boatioader

WiFi module

Toox family
Ardbox GPRS family

[®] Ardbox WIFI/BT family
M-Duino family

I (. Duino GPRS family I

Once it is selected the Ardbox Family or Ardbox WiFi & BLE family an extra option will
appear on Tools:

- Select the correct Ardbox WiFi Board (Ardbox Relay HF+ w/HW RS-232 WiFi/BT or
Ardbox Relay HF+ w/HW RS-485 WiFi/BT) depending on your jumpers & switch
configuration.

@ sketch_aug26a | Arduino 189 - o ®
File Edit Sketch Tools Help

Auto Format CeT
Archive Sketch
Fix Encoding & Reload

Manage Libraries. Ctrl+Shifts] =
Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+Shift+L

WIFI101 / WIFININA Firmware Updater

oyl Board: “Adboc WHFiBT family >

Maodel: “Ardbox Analog HF+ v/ HW RS-232 WiFi/BT" 2[8] ardbox Analog HE+ w/ HW RS-232 WFi/BT

’ t ‘Ardbax Analog HF + w/ HW RS-485 WiFi/BT
Get Board Info Ardbo Relay HF + w/ HW RS-232 Wi (/BT

g - Ardbox Relay HF + w/ HW RS-485 WiFi/BT
Pragrammer: “Arduing Gemma

Bum Bootioader

17



Ref. 007001001300 Rev. 2: 04-02-2022

Also there are some examples of programming in File -> Examples -> Ardbox Family.
Furthermore, there are some extra libraries that can be found in Industrial Shields GitHub.

https://github.com/IndustrialShields/
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5. How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
Ardbox Family uses micro USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> Ardbox Family
- Select correct port.

@ sketch_mar16a | Arduino 180
File Edit Sketch Tools Help
colsT

.. Serial Moritor ColaShifeaM
7 Senal Plotter ColsShitesd
WIF101 Firmware Updater
Boardt “Ardbas family

Inchustrial Shields: “Ardbox Analag”
C pen

{ senal pons
Y GetBoardinto COM13 (Archina | conarcdo)
, Programmer:Archin as ISP
Bum Baotioarer
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6. How to connect PLC to power supply

- Ardbox Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

[——
u GHND I

|—1I 24Voe |

e ——
- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm )

. = il
DIN Rail: % |
-12vdc / 24Vdc =
-2.5A
-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent
protection. There is a LED inductor for power status,

TEBE |

the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.
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7. Ardbox Relay w/WiFi & BLE 1/0 pinout:

Zone Connections

— c
8 o
c
58 g 9
o E 5 o
© e <
- O = >
<O < I
™ wE
NC ;
L | HD-FDx 3
RS/PIN3-SCL
10.0/PIN-SDA |3
RE-RS485/104
10.4/RE-RS485
DE-RS485/105 | |2
1.05/DE-R$485
N mr
MISO 14 | SPI-MISO / Wi-Fi MISD
MOSI 16 | SPI-MOSI / Wi-Fi MDSI %
SCK 15 SPI-CLOCK SCK &
RESET - SPI-RESET RESET
5vdC - 5V Output SVdc
GND - GND GND
RX-RS-23212 | 8 Serial/RS232 T —
TX-RS-232t2 | 4 Serial/RS232 X
SCL-PIN2! 2 12C/SPI SS PING-SDA | &
SDA-PIN3L 3 12C/SPI SS PIN3-SCL | %
"\
LRI
R1 10 | Relay10ut \Rr?
R2 9 Relay 2 Out =t
R3 6 Relay 3 Out
iz
GND - GND w
Y i ) GND gg
— (Vdc |*

HS*: Hardware Serial
SS*: Software Serial

1 See section 8 to enable these connections
2 See section 9 to enable these connections

LEFT ZONE

Switch config*

(see section 8 for Communications
configuration. Enabling Communications
disables some 1/0s)

Communications pins

Relay Outputs

Power supply connectors
(24vdc - GND)
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5| &2

58| 28 S

o £ R I3]

2ol Tuw S

<O < [

B- - RS485

A+ RS485

Z-1A0.1 - RS485/Digital Output
Y+/A0.0 RS485/Digital Output

R4 5 Relay 4 Out

R5 3 Relay 5 Out
10.9 23 Analog/Digital Input
10.8 22 Analog/Digital Input
10.7 21 Analog/Digital Input
10.6 20 Analog/Digital Input
10.5% 19 Analog/Digital Input
10.41 18 Analog/Digital Input
10.32 Analog/Digital Input
10.22 4 Analog/Digital Input
10.1 12 Digital Input
10.0t 2 Digital Input/ Interrupt
R6 7 Relay 6 Out
R71 0 Relay 7 Out
Rt 1 Relay 8 Out

¥ Note: use correctly configuration for

use this signal.

(see user guice)

*Depending on the mode HD/FD the Y+/Z- analog outputs pins are enabled or disabled. See
section 9 to see the configurations

Rev. 2: 04-02-2022

RIGHT ZONE

RS-485 pins
Analog Outputs Pins

Relay Outputs

Digital/Analog Inputs pins

Relay Outputs

& [ndustrial Shields

www.industrialshields.com

Ardbox Relay HF+
Ref ISAR20RELAF +
Analog, Input (0-10¥dc)
Digital Imput ¢5-24Vdc)
Apalog Dutput (0-10Vele)

Relay Output ¢ 220%ac - 3A mex)

X & o~ S o ot U o e
2 &2 o I~ o 5] — = P = = — [l w
. < = 3
=] o - 'R
:_ 8:{ £ — ']FI"'
s E P W
o <T
= = | . ; A\
Config switch *
(see section 8 for communications Input / Output LED Power LED

configuration)

Qam
Alm.12-24Vdc
B0W i 2017

RESET

Arduino Reset button
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8. Switch configuration

8.1 General Switches Configurations

LEFT ZONE SWITCH
Communications and inputs/outputs can not work simultaneously.

LEFT ZONE
ON QFF
SWITCH ON OFF
NG
NC - - HD - FD*
HD/FD* Half Duplex Full Duplex R5/PIN3-SCL
R5/Pin3-SDA R5 PIN3 - SDA 10.0/PIN2-SDA
10.0/Pin2-SCL 10.0 PIN2 - SCL RE-RS485/10 4
RE-RS485/10.4 RE-RS485 0.4 10.4/RE-RS485
10.4/RE-RS485 10.4 RE-RS485 DISREFESIDS
10.5/DE-RS485
DE-RS485/10.5 DE-RS485 10.5 = —
10.5/DE-RS485 10.5 DE-RS485

1. NC- Not Connected

2. HD/FD* — Choosing between Half/Full Duplex for the RS485 communication. In order
to use Full Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE(*see
section 9).

3. R5/ Pin3-SCL — If this switch is ON the R5 is activated, otherwise the Pin3 - SDA will be
activated.

4. 10.0 / Pin2-SDA — If this switch is ON the 10.0 is activated, otherwise the Pin2 - SCL will
be activated.

5. RE-RS485 / 10.4 — If this switch is ON the RE-RS485 is activated, otherwise the 10.4 will
be activated.

6. 10.4 / RE-RS485 — If this switch is ON the 10.4 is activated, otherwise the RE-RS485 will
be activated.

Note* To work with RS-485 RE, switch number 5 at ON and number 6 at OFF.

7. DE-RS485 / 10.5 — If this switch is ON the DE-RS485 is activated, otherwise the 10.5 will
be activated.

8. 10.5 / DE-RS485- If this switch is ON the 10.5 is activated, otherwise the DE-RS485 will

be activated.

Note* To work with RS-485 DE, switch number 7 at ON and number 8 at OFF.
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TOP ZONE SWITCH

TOP ZONE ON OFF
SWITCH ON OFF RS*
RS*/ R8 RS* RS R8
R8/ RS* RS RS* RS*
RS* /R7 RS* R7 R7*
R7 /RS* R7 RS*

Communications and outputs cannot work simultaneously.

4. RS* / R8 - If this switch is ON the RS* is activated, otherwise the R8 will be activated.
3. R8 / RS* - If this switch is ON the R8 is activated, otherwise the RS* will be activated.
2. RS* / R7 - If this switch is ON the RS* is activated, otherwise the R7 will be activated.
1. R7 / RS* - If this switch is ON the R7 is activated, otherwise the RS* will be activated.

Note* RS * can be RS-485 or RS-232 depending on the jumper configuration you have chosen.
To work with RS*, switches number 1 and 3 at ON and number 2 and 4 at OFF.

8.2 RS- 485 Switch configuration

RS-485 TOP ZONE: In order to enable the RS-485 protocol the
TOP ZONE must be configured as it is shown in the table.

Having this setup, the R7 & R8 are disabled.

RS-485 LEFT ZONE: In order to enable the RS-485

communication protocol it is necessary that the switches

of the left zone are configured as it is showed in the

table.

The ones marked with “-“ mean that they don’t affect the

RS-485 communication protocol.

TOP ZONE
SWITCH MODE
RS* / R8 ON
R8/ RS* OFF
RS* /R7 ON
R7 /RS* OFF
LEFT ZONE
SWITCH MODE
NC -
HD/FD* ON/OFF
R5/Pin3-SDA -
10.0/Pin2-SCL -
RE-RS485/10.4 ON
10.4/RE-RS485 OFF
DE-RS485/10.5 ON
10.5/DE-RS485 OFF

* To enable the RS-485 communication it is needed to configure also the jumpers, see Section
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8.3 RS- 485 Switch configuration

RS-232 TOP ZONE: In order to enable the RS-232
communication protocol it is necessary that the switches of
the top zone are configured as it is shown in the table.

RS-232 LEFT ZONE: In order to enable the RS-232

communication protocol it is necessary that the switches

of the left zone is configured as it is showed in the table.

None of them affects to the RS-232 communication but if

you are using it you can use also use the inputs 10.4 and

10.5.

The ones marked with “-“ mean that it does not affect

the RS-232 communication protocol

TOP ZONE
SWITCH MODE
RS*/ 10.2 OFF
10.2 / RS* ON
RS* /10.3 OFF
10.3 /RS* ON
LEFT ZONE
SWITCH MODE
NC -
HD/FD* ON/OFF
R5/Pin3-SDA -
10.0/Pin2-SCL -
10.4/RE-RS485 ON
RE-RS485/10.4 OFF
10.5/DE-RS485 ON
DE-RS485/10.5 OFF

* To enable the RS-485 communication it is needed to configure also the jumpers, see Section

8.4  12C Switch configuration

TOP ZONE

SWITCH MODE
RS* / 10.2
0.2/ RS*
RS*/10.3
10.3 /RS*

LEFT ZONE
SWITCH MODE
NC -
HD/FD* -
R5/Pin3-SDA OFF
10.0/Pin2-SCL OFF

10.4/RE-RS485 -
RE-RS485/10.4 -
10.5/DE-RS485 -
DE-RS485/10.5 -

To enable 12C configuration the switches SDA/R5 & SCL/10.0 must be set to ON. As they are in

ON mode R5 & 10.0 are disabled.

The switches marked as “ —“ don’t interfere with the 12C communication protocol.
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9. Jumper Configuration

9.1

JUMPER ZONE 1

LEFT RIGHT
Y+ Z-
ENABLE ENABLE
A0.0 A0.1

JUMPER ZONE 2

LEFT RIGHT
10.2 10.3
D4 D8

RS-232 RS-232

JUMPER ZONE 3

uUpP RS-485

D1 | RS-232

DOWN | RS-485

DO | RS-232

General jumper configuration

This jumper zone makes the selection between using the RS-485 Full
Duplex or the Analog Outputs. If it is wanted to use the RS-485 Full
Duplex communication protocol the Y+ must be connected to ENABLE,
and Z- also connected to ENABLE. If it is wanted to use the Analog
Outputs, The A0.0 must be connected to ENABLE, and AO0.1 also
connected to Enable

This jumper zone makes the choosing between connecting the inputs
10.2, 10.3 to pins 4 and 8 of the Arduino Leonardo respectively, or
connect the RS-232 ports to activate the Software Serial RS-232. In
order to use the inputs 10.2,10.3 the jumper must be connected to the
pins 4 and 8. So 10.2 must be connected with D4 and 10.3 must be
connected to D8.

This jumper makes the choosing between connecting MAX232 to pins
0,1 of the Arduino Leonardo or with the MAX485. In order to use the
RS-232 Hardware Serial protocol both RS-232 must be connected to
the D1/DO. In order to use the RS-485 Hardware Serial protocol both
RS-485 must be connected to the D1/DO0.

*The jumpers that are not connected to the middle jumpers MUST NOT be connected anywhere.

.“ RS-232

HARDWARE

. “ SERIAL

@O @ rs-:ss

HARDWARE
SERIAL

RS-232
SOFTWARE
SERIAL

Dlgltal
Inputs
18.2
18.3
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10. Hardware Serial RS-232 & RS-485 Configuration

10.1 Hardware Serial RS-485

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Relay HF
PLUS will be:

Switch configuration:

TOP ZONE

LEFT ZONE

Jumper configuration:

ZONE 1 ZONE 2 ZONE 3

o0
t 3 9P

HARDWARE
[ X | [ ¥ JEe
Analog Digital
Dutputs Inputs
Ad. B 18.2
A8.1 8.3

Available communication protocols:

e Hardware Serial RS-485

e [2C *If 12C is active R5 & 10.0 are disabled
e SPI|

o TTL

e USB
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10.2 Hardware Serial RS-232

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Relay HF
will be:

Switch configuration:

TOP ZONE

LEFT ZONE

Jumper configuration:

ZONE 1 ZONE 2 ZONE 3

o0
t t O0P .

00 009

Analog il

Outputs Digital
AR .8 Inputs
48,1 I8.2

o Available communication protocols:
e Hardware Serial RS-485.
e [2C *If 12C is actived R5 & 10.0 are disabled
e SPI|
o TTL
e USB
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11. Ardbox - Arduino I/0s 5V pins

The Ardbox has some of the Leonardo board pins available. These pins can be programmed
according to Arduino features such as |/Os operating at 5V or any additional features present
in the pins (for example 12C communication in pins SCL and SDA). As this pins are directly
connected to the Arduino Leonardo board they are not as well protect as the normal inputs.
These pins are mainly meant to be used as prototyping.

Ardbox terminal Arduino pin
SCL—-Pin 3 3
SDA —Pin 2 2
MISO 14
SCK 15
MOSI 16

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Leonardo board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

11.1 I2C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. The 12C pins in the Arduino
Leonardo are not pull-up, so in order to work with the 12C an external pull-up resistor is
required. If it is meant to work as a GPIO at 5V, the switches must be set as 12C, (section 8).

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

11.2 Pin2/Pin 3

These pins are only referred to the inputs 10.5/10.6. If the switch configuration is in OFF
position the pins Pin 2/Pin 3 will be available.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.
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11.1 SPI- MISO/MOSI/SCK
These pins are used for the WiFi & BLE module.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established an external pull-up or pull-down circuit in order to correctly work with
these pins.

WARNING: The SPI cannot be used simultaneously when the Wi-Fi module is communicating
with the Arduino Leonardo.

12. WiFi & BLE

The WiFi and Bluetooth integrated module consists in a single 2.4 GHz Wi-Fi and Bluetooth
combo chip designed with the TSMC ultra-low-power 40 nm technology. It is designed to
achieve the best power and RF performance, showing robustness, versatility and reliability in a
wide variety of applications and power scenarios. Some applications are Generic Low-power
loT Sensor Hub, Generic Low-power loT Data Loggers and Mesh Network.

It is designed for Internet-of-Things (loT) applications.

12.1 General Specifications:

Wi-Fi

e 802.11b/g/n

e 802.11 n (2.4 GHz), up to 150 Mbps
Bluetooth

e Bluetooth 4.2 BR/EDR BLE dual mode controller
e +12 dBm transmitting power
e NZIF receiver with -97 dBm BLE sensitivity

12.2 WiFi & Bluetooth Module Configuration

In order to configure the WiFi & BLE module, you must connect it to a PC.
To connect it you will need a micro USB to USB cable.

The slot for the micro USB input is located on the right side of your equipment.
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To load the program into the ESP32 you have to use the apropiate board. For that, update our
board to the latest version. Go to Tools -> Board -> Boards Manager. Shearch by Industrial

shields-esp32.

@ Boards Manager

Type | Al « | [industrial shields-esp32)

industrialshields-esp32 version 1.0.1 INSTALLED
Boards included in this package:

WiFi/BT module.

Online help

Mors info

.. Remove
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Now you are able to install the board. Go to Tools > Boards -> WiFi module.

9 sketch_aug13a | Arduino 1,89
File Edit Sketch Tools Help

Aute Format Ctrl+T
Archive Sketch
sketeh_aug13 Fix Encoding & Reload
vold setup( Manage Libraries... Ctrl+Shift+|
// put yor Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+5Shift+L

WiFi101 £ WiFiNINA Firmware Updater
void loop()

// put yor Board: "WiFi medule” 3 Boards Manager...
Port
N ry
Get Board Info Arduino Mini

Arduino Ethernet
Arduino Fie

Arduino BT

LilyPad Arduino USB
LilyPad Arduino
Arduino Pro or Pro Mini
Arduino NG or elder
Arduino Robot Control

Programmer: "Arduino as I5P"

Burn Bootloader

Arduino Robot Motor

Arduino Gemma

Adafruit Circuit Playground

Arduino Yin Mini

Arduino Industrial 101

Linino One

Arduino Uno WiFi

Industrial Shields ESP32 modules
[ Wifimodule

Industrial Shields boards

Ardbox family
Ardbox GPRS family
Ardbox WiFi/BT family
M-Duina family

¥

The internal connections between the ESP32 module and the Arduino Leonardo are the

following:
Ardbox Relay 20 I/0Os WiFi & BLE ESP32 Pinout
Modbus
5Vdc Vee
GND GND
MISO TxD

MOSI RxD
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WiFi and Bluetooth are always enabled as there are no switches that configure it.
The WiFi and Bluetooth module uses SPI for communication.

More information: https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-
bluetooth-module-esp32-devkit-v1-133

WARNING: The SPI cannot be used simultaneously when the Wi-Fi module is communicating
with the Arduino Leonardo.

33


https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-bluetooth-module-esp32-devkit-v1-133
https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-bluetooth-module-esp32-devkit-v1-133

Ref. 007001001300

13. I/0 technical details

Digital Output Waveform

[l o e—
v

DIGITALOUT

DIGITAL OUT

ARDLINOOUT

Rev. 2: 04-02-2022
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PWM Waveform

PWM OUTPOUT

ANALDG OUT

Rev. 2: 04-02-2022
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Analog/Digital Input Turn-on

SIGMALIM

e
AMALOGDIGITALIM

Rev. 2: 04-02-2022
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14. Typical Connections

—a/oilm

Ferrite KITA

@( v ol POWER
2024¢ B ocomaw
SHIELDED CABLE E:M;\\

SHIELDED CAEBLE 0-10v
51224V M, 107
GND
Ferrite KITA
ﬁ'“ ) POWER
12724V B ooraanaoeN

SHIELDED CABLE ; Dounioed o MOURNO LAYOUT: \
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N
)

>,

Ferrite KITA
'

J

l

i

/4

Ferrite Kl

)

SHIELDED CABLE,

0.7
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SHIELDED CABLE

oy

ALWAYS

CONNECTED
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SHIELDED CABLE

Ferrite KIT#

Rev. 2: 04-02-2022

GND

2024V

J

VOUT = Q/Vde

Ferrite KITA

GND

9)

I

SHIELDED CABL

SHIELDED CABLE

* Soe the switch
configutarion (ON)

'-..\}

VOUT = Q/ Vide

)

ALWAYS

\z

SHIELDED CAELE
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///’— Am\\
Q ANALOG OUTPUT
'\ * Analog Outs no led '
indicator
T - g * See the switch
©a0los ) configutarion (OFF)

070 g Olos
05 04’0 04 GND -

Oab T 010V
03O g Ofoa A0S

{ 2 00

SHIELDED CABLE

Ferrite KITA -

- o)} poner
224V 1 § awocour
SHIELDED CABLE ) m"‘mum \
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15. Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MCO0,5/10-G-2,5THT

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference  MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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16.

ARDBOX Family Dimensions:

45mm width

- DIN rail mounting:

Rev. 2: 04-02-2022

&

114

— 3503

Profilato o cappello TH 35-7,5
Top hat rail TH 35-7,5

153,

ROS

RO8

Prafilato o coppello TH 35-15
Top hot rail TH 35-15

155
-

1=0.04
15°

=

=

+

S 1004
v Sezione A / Section A .
0.3 max o4 2,2 min. finoa / To 2,5 max
?; -
B Sezione A/ Sedtion A

CARATTERISTICHE METODO ~ UNTA'  BLEND FEATURES TEST UNITS  BLEND
DIMISURA PU/ABS METHOD PUABS
Mecconiche R iong ol KSTMD638  WPg 68 Mechanical fest Resiionce o tesile stess o vield ASTMD38 MRy 68
Re otug KSTIAD638  MPo % Tenslestrongt ASTMDG638 MRy 4%
Alngomento o totvn KSTHD63 % 9 Ut Jongat ASTMD638 % 9
Modulo in fesione KTADI0  WPo 2694 Flring moduls ASTADTS0 MR 289
Provo I20d con intoglio 150180/14  Xyni" 55 rod st oiched 1018014 X' 55
Termiche i pmmoliments Viat, e 01 °C 114 Thermal fest Vit sodten metiodB  ASTADISIS °C 114
Temperatue Riat 1 81 MRy KTM0648  °C 97 Reheting temperatue 1,81 WPg ASTMDG48  °C 9
Fisiche Peso speditn KU géand 12 Physical test  Spacic gmvity ASTRDTS?  gy/and 2
Ri nel stompo KUADSS % 0406 Mould hiinkoge ASTMD9SS % 0408
Melt Flow Index 260°C - 98N KUADIZE  g/10° 1 Met Fow index 260°C - 98K ASTMDIZE g0’ 1R}
Comportamento Aubesinguerzo (i di pessoe) [[E) - V-0(08) Flome fest Selfainguisher (tidness in mm) s - v0(08)
allo fiomma _Fio Incardescen 32 mm 69521 °C 960 Ingondescents thieod 32 mim 169521 960

Italtronic si riserva il diritto di modificore il moteriole con cui realizza i propri prodotti

senzo obbligo di preawiso.

Italtronic con operate any change of the moterials without being obliged to forewarn.
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17.Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/0 of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the ARDBOX 20 I/Os Relay HF WIFI & BLE 1/0Os PLUS from heat, high
voltaje and eletrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
ARDBOX 20 I/Os Relay HF WIFI & BLE. When configuring the layout of the ARDBOX 20 I/Os
Relay HF WIFI & BLE inside your panel, consider the heat-generating devices and locate the
electronic-type devices in the cooler areas of your cabinet. Reducing the exposure to a
high-temperature environment will extend the operating life of any electronic device.
Consider also the routing of the wiring for the devices in the electric cabinet. Avoid placing
low-voltage signal wires and communications cables in the same tray with AC power wiring
and highenergy, rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring ARDBOX 20 I/Os Relay HF WIFI & BLE. Is
designed for natural convection cooling. For proper cooling, you must provide a clearance of at
least 25 mm above and below the devices. Also, allow at least 25 mm of depth between the
front of the modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25¢cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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18. Revision Table

Rev. 2: 04-02-2022

Revision Number Date Changes
0 30/08/2019 First implementation
1 02/03/2020 Second implementation
2 04/ 02 / 2022 Third implementation
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com

Rev. 2: 04-02-2022
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